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Introduction
Practice is over! You’ve played the com-
petition; now it's  time to bang heads with
the big boys! Welcome to All-American
College  Football-the most comprehensive
simulation o f  college football ever created!

Coach your favorite college team through a
full schedule of hard-hiting action. Play
head-to-head match-ups either locally or via
modem. Create a league and play scheduled
games in either head-up or Micro Sports’
exclusive Game Plan mode. Whatever your
preference, A//-American College Football
can deliver! What’s more, each play is
tracked by the Stats Keeper module, which
provides pages of the most complete stalisti-
cal  reports found in anycomputer game!

Game Features
Here are some of the features you’ll find in
All-American College  Football:

. College teams, with full rosters made up
o f  actual college players.

. The ability to manage four
separate leagues.

. Auto Play mode for rapid simulation
of scheduled games.

l True modem play,

. Two play styles-Head Up or Game
Plan mode.

l Stunning graphics.

l Play-by-play commentary.
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How to Use This  Manual
Your owner's  manual contains five main sec-
tions and a glossary:

Getting  Started-Includes  the hardware
requirements for All-American  College
Football as well as how to install and load
the program.

Playing  All-American College Football-
Contains chapters that describe the Game
Setup Screen, tell how to play the Head Up
game, or the Game Plan; and lead you
through your first modem play connection.

Game Utilities-A series of seven chap-
ters, each devoted to one of the utilities
found in All-American College Football,

Glossary of Terms-Your resource for
football terminology and game strategies.

Get  in  the  Game!
To get the most out of All-American College
Football, play it with a friend, either at the
keyboard or via modem. If you can’t find an
opponent locally, you can always find worthy
competition on commercial bulletin board
services. What’s more, these services
frequently sponsor leagues, with online sec-
tion leaders acting as league commissioners.
So, what are you waiting for?  Get online and
get in the game!

1 G e t t i n g  S t a r t e d
System  Re  irements
Here’s what you need to play All-American

C o l l e g e  Football:

l DOS 6.0
l 486/25 MHz IBM or 100% compatible PC

(486/33  MHz recommended)
l 8MBRAM
l VGA
l 24 MB free hard disk space
l CD-ROM drive (double  speed)
l Mouse 
l AdLib,  Sound Blaster” or 100% compati-

ble sound card

Opt iona l  Equ ipment
l Hayes-compatible modem
l A printer that supports 132-column

printing

 Installing  All-American
College  Football
Follow this procedure to install All-American
College football into your hard drive:

1.  Insert the CD-ROM into your CD-ROM
drive and type the drive identifier followed
by a colon (e.g., D:). Press <ENTER>.

2. Type INSTALL and press <ENTER>.

3. Follow the on-screen prompts.

4. After the install program is finished, it dis-
plays menus to configure your sound and
print options. Choose your sound and
print options from these menus.

Defining  "Select”
You will see the term ‘Select’ used in most
sections of this game manual. There are two
ways to select an item:

1. Using your keyboards direction arrow
keys, move the dotted highlight box to the
item you want to choose. Press <ENTER>
to select the item.
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2.  Using your mouse, move the mouse
pointer over the item you want to choose.
Click the left mouse button to select  the
Item.

HINT:  It  is much easier to select  items
using the mouse.

Selecting Pull-Down Menus
Nearly every screen has a bar at the top with
two or more pull-down menus. To select a
menu, click on its title with the left mouse
button.

When you select a pull-down menu, a list of
menu items appears. If you are using a
mouse, click on the menu item you want to
execute. If you are using the keyboard, use
the up and down direction arrows to high-
light the item you want to select. Press
<ENTER> to make your choice.

To clear a drop-down menu without making a
selection click the left mouse button outside
the menu.

The <ESC> Key
You can use <ESC> to clear dialog boxes
from the screen and cancel selections in
process.

The <ESC> key also serves as a quick-exit
key from all programs within All-American
College Football. You will, however, be
prompted to confirm your exit when you
press the <ESC> key to perform a quick exit.

loading the Game
To load All-American  College Football,
change to the drive and directory where you
installed the game (e.g., C:\ACF95).  Type
ACF95  and press <ENTER>. The General
Manager menu appears.

The General Manager Menu
General Manager provides you with an easy-
to-use interface and a few extra features that
make playing All-American  College Football
as easy as possible. This is the General
Manager Menu screen:

General Manager Features
The top of the screen houses three pull-down
menus:

He/p-Provides a list of hot keys and a
description of each on-screen selection.

File-Allows you to view game credits
and exit the game.

Utility- Gives you the option of printing a
game plan form or the predesigned plays.
See Printing Playbooks for more information
about printing predesigned plays. It also
allows you to access the remote league
data module.

The bottom of the screen is filled with but-
tons corresponding to the different modules
in All-American College Football. Each is
discussed in detail later in this manual.

Printing Playbooks
Press <F8>  or choose Print  Playbook from
the Print menu to print the playbook  Form or
Diagram. The Form is a coded listing of each
predefined offensive, defensive, and special
teams play.

Choose Diagram to print graphical represen-
tations of the predefined plays. You can
print them in any formation (using a laser
printer only).

The game asks you to select an offensive
formation, defensive formation, printer type,
and play types to print. This is the list of
play types:

l Offensive Run Plays (01-30)
l Offensive Run Plays (31-44)
l Offensive Pass Plays (45-74)
l Offensive Pass Plays (75-94)
l Run Defense Plays (01-30)
l Run Defense Plays (31-46)
l Pass Defense Plays (47-76)
l Pass Defense Plays (77-94)
l All Plays (Offense and Defense)

After your selection has printed, the play
selection menu reappears.

Choose another set of plays to print or select
Exit Playbook  Printing to return to the
General Manager screen.
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Game Setup Play  Method

The Game Setup menu is the launch pad for
This sets the type of game you are going to

all All-American  College Football  action.
play. The choices are Head Up and Game

This is where you set all game parameters,
Plan. In a Head Up game, you call each play

such as the teams that are playing, the type
and make all coaching decisions in real time.

of game being played, and a number of
A Game Plan  game requires you to fill out a

other important options. Each choice on the
strategy sheet. The computer then uses the

Game Setup screen is described on the fol-
decisions you and your opponent made on

lowing pages.
your strategy sheets to simulate the game.
See the chapter  titled Plavino All-American

Using the Game Setup Screen
To chanoe default ootions on this screen.

College  Football  for more information  about
each of these play methods.

select the corresponding white button multi-
ple times until the desired choice appears in

G a m e  T y p e

the white box to the right. Keyboard users:
The options for this category are Normal,

navigate using the arrow keys, and press
Modem, Repeat, and Autoplay. Choose

<ENTER> to change the default options.
Normal to play Head Up or Game Plan
games  locally fon vour PC). Choose Modem

G a m e  O p t i o n s to play Head Up games  viamodem. Choose
The following is a description of each option Repeat to  replay a Game Plan  game and
  on the left side of the Game Setup screen: receive the same result each time. This game

type is used in commissioner-run leagues to
ensure consistent results. Choose Autoplay
to quickly simulate Game Plan  games  or
replay an entire College season.

Tie  Resolution
This determines how the game will continue
if there is a tie score at the end of regulation.
Overtime means  the teams will play one
overtime period. The first team to score in
that overtime period wins the game. Sudden
Death means the game will continue until a
team scores (however long that takes!). Tie
means the scare will remain tied.

Computer’s Team
This determines which team the computer
will coach. Make this selection only if you
are playing against the computer. Otherwise,
it is not applicable.

TeamsTeams
The Teams button functions differently forThe Teams button functions differently for
league and exhibition games. See league toleague and exhibition games. See league to
Use for instructions on choosing a league orUse for instructions on choosing a league or
exhibition game.exhibition game.

Exhibition Games: You must first choose a
Visitor and Home team. Select either choice.
A menu is displayed containing all the col-
lege teams. Choose a team, and then choose

a year from the subsequent menu. Repeat
this process to select the opposing team.

League Games: The  game displays the
appropriate league schedule (based on the
league selected in the League to Use box).
Select a game from the schedule. League
games that have already been played do
not appear.

League to Us.9
Use this button to choose a league or exhibi-
tion game. To play an exhibition game, cycle
through the choices until Exhibition appears.
To play a league game, select a league fife
to open.

Vis.  G a m e  P l a n
If playing a Game Plan  game, select how the
visitor will generate his strategy sheet. The
choices are Computer (the  computer gener-  
ates the sheet), Saved (the  computer will
read a predefined strategy sheet from disk),
and Manual (the  player creates the sheet
before the game begins).

8 9



Home Game Plan
Same as I/is. Game Plan,  but for the
home team.

Weather
Here is where you decide if you want  to use
weather effects in your game. If you choose
Use,  you then have the choice of manually or
automatically setting the weather (see Set
Weather). Choosing Don't  Use puts you in
neutral conditions.

If you choose to use weather effects, this is
where you decide if you want to set them
yourself (Manual),  or have the computer
generate the conditions (Computer).  If you
select Manual you will set these conditions
before the game begins:

l Temperature
l Wind Speed
l Type and Degree of Precipitation

For exhibition games, select the month of the
game (September-February).  This affects  the
temperature and type of precipitation, if any,
during the game.

Injuries
This button allows you to turn injuries on
(Use) or off (Don't  Use) for your game.

Coin Toss
Choose which side of the coin the visiting
team will call before the game (Heads or
Tails).

Modem Play Options
These are the modem play options. You only
need to set them if you are playing via
modem.

Choose which person will place the call, you
or your opponent.

NOTE: Call waiting phone service can dis-
rupt a modem connection, and must be tem-
porarily disabled to play All-American

College Footballvia modem. If you or your
opponent has this service, the player with
call waiting must place the call. Otherwise,
the service cannot be disabled, and you run
the risk of being suddenly disconnected by
an incoming call.

For more information about disabling call
waiting, see the section titled Dialing
Prefixes in the Modem Play chapter.

Caller’s  Team
This selection works with the Calling  Coach
button. The caller has the option of choosing
which team he will coach, the Home team  or
Visitor.

Comm  Port
This is where you tell the game where your
modem is connected to your computer.
Select the appropriate port  (Com1 - Com4).
If you choose Com3  or Com4, the computer
gives you the option of setting the base
memory address and interrupt used by your
modem. See your modem manual for these
settings.

Dialing Prefix
If you are dialing from a touch-tone phone,
choose ATDT.  If you have pulse service,
choose ATOP.

Modem Init ial izer
On rare occasions you may need to change
the modem initialization string to use this
module with your modem. If you determine
that you are having trouble connecting
because of an incompatible initialization,
select this button and type the new string.
Press <ENTER> when finished. Refer to
your modem manual for details on what the
initialization should be for your particular
modem.

The Options Menu
The Options pull-down menu includes even
more choices you can use to customize your 
game. These are summarized below.
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This is where you can designate your game
to be played on artificial  turf. After choosing
this item, the game displays a box describing
your choices. Choose On to use artificial
turn; Off to  use the field that corresponds to
the weather conditions.

Here is where you can turn sound effects on
or off.

Animation Speed
Choose this option to vary the game’s
animation speed. Input a number between
1 and 200, with 1 being the fastest and
200 being the slowest animation speed.

12

Autoplay  Speed
When playing an Autoplay game,  you can
use this menu choice to determine how the
animation will appear. If you choose Fast, the
game will track the ball position and update
the scoreboard for every game. This takes
about 14 seconds per game on a 486DX2/66
machine.

If you choose Real  Fast, the computer simply
determines the outcome and reports the
score, without updating the scoreboard
throughout the game. This takes about 4 sec-
onds per game on a 486DX2/66  computer.
Both modes generate full statistics at the end
of each game.

Game Summary
This option, if activated, tells the computer to
prompt you at the end of each game to view
game statistics. If you do not care to view
game statistics after each game, turn this
choice Off.

Starting the Game
When finished making selections, choose
Let's Do It! to begin the game.

Playing All-American
College Football
Playing a Head  Up Game
Whether you’re playing  against the computer
or a friend, local or via modem, the Head Up
game puts you in charge of all the action!
This section is designed to familiarize you
with the Head Up screen, and teach you
how to make your Head Up experience even
more thrilling.

Game Setup Selections
To play a Head Up game, you must be sure
that Play Method is set to Head Up on the
Game Setup screen. All other selections on
this screen are optional, and are covered in
detail in the previous chapter.

The Head Up Screen
The Head Up screen is divided into six main
sections, each of which is described on the
following pages.

Pull-Down Menus
Across the top of all Head Up screens is a
series of pull-down menus that allow easy
access to some special game features. The
following is a brief summary of the pull-
down menus:

File-Where you can save and restore your
game, print game information, or exit the
game entirely.

NOTE: To restore a game, you must choose
the same visiting and home teams on the
Game Setup screen as are included in your
saved game file. After the game animates
the kick-off, choose Restore to resume the
saved game.

Options-Includes selections for display-
ing injury and weather reports, setting  the
play delay, changing the game scenario,
enabling/disabling game sound and/or the
play clock, and choosing the play calling
method.
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Game  stats-Allows you to quickly review
Offensive and defensive statistics, as well as
the drive summary, player ratings, and team
tendencies.

Substitute-Where you can substitute
players for either the home or visiting team.

Field-This menu lets you set the anima-
tion scroll speed, select the player you want
the animation to follow (1 of 22), and turn
jump scroll on or off. Use jump scroll on
slower machines.

Scoreboard

The scoreboard keeps track of vital game
information, including the score by quarter,
possession, ball position, time outs remain-
ing,  and time to go in the quarter.

Commentary
This is where the game reports the result of
the previous play. It shows the offensive and
defensive play, players involved, and result.

Field
In the center of the screen is a miniature view
of the field that tracks the ball position dur-
ing the game.

Play  Clack
If enabled, the play clock displays the time
remaining to call  a play. If you don’t call a
play before the clock expires, you will be
charged with a delay-of-game penalty.

This area also includes the play input boxes
you use to call plays via the keyboard.

Play Calling Buttons
Each of these buttons takes you to a different
screen where you can call  your play. If you
choose Call Play, the Qame displays the list
of available plays from the All-American
College  Football playbook. If you choose
Define Play, the game displays the play
design utility, where you can set your play
manually.

Function Keys
The following function keys are active when
playing a Head Up Qame. They give you an
easy way to control how the game's  anima-
tion functions.

<F9>- Manual  scroll (use arrow keys)

<F10>-Follow  ball

<F11>-Center  animation over the last
active player

<F12>-Jump  scroll (if on) will center on
the ball or on the last active player

Play Calling
There are two different ways to call plays
during a Head Up game. You must use one
method when playing against the computer
or via modem, and the other way when play-
ing against a friend  on the same computer.

When playing a Head Up game against the
computer or via modem, use the play calling
buttons and their subsequent screens to call
your plays. These buttons are labeled Call
Play and  Define Play, and are at the bottom
of the Head Up screen.

When playing against a friend on the same
computer, you both can either type in the
play number found on the enclosed play
cards or use the play calling buttons.

If using the keyboard, the home team coach
uses the numeric keypad to input his plays,
while the visiting team coach uses the num-
ber row on the keyboard to call his plays.
Make sure the Num Lock key is on before
you begin.

The following describes how to call plays
using the Call Play and Define Play buttons. 
See the section Play Calling-Two  Human
Players for more information about typing in
your play number.
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Play Calling-Using  Play
Calling Buttons
Chose Call  Play or Define Play from  the main
Head Up screen.

HINT: It is quicker to calf a preset play than
design your own. If you are trying to con-
serve time, it is best to call  a preset play If,
however, you want to keep your opponent on
his toes, use the Define Play feature.

NOTE: Consult the Glossary of Terms at  the
end of this manual to learn definitions of any
football terms found on the play calling
screens.

Preset vs. Define
If you call a Preset play, the game asks if you
want to call a run play, pass play, or kick
play. Choose one of the three. The appropri-
ate list of predefined plays appears on the
play calling screen. Select a play from the
play list.

If you decide to define your own play, the
play design screen appears. To define a play,
you must make decisions for each applicable
subcategory on this screen (each of which
is described in the Glossary of Terms).  For
example, you do not need to choose a
receiver if you are calling a running play.

Time  O u t
Once you have selected or defined the play
y o u  want to call, you must decide if you want
to call a time out upon completion of the
play. To call  a time out after the play is com-
plete, select Call  Play/Time  Out. Otherwise,
select Call Play/No  Time Out

Time management is very important in foot-
ball, so be sure to call time outs only when
necessary. For example, don’t call a time out
if one of these events will occur at the end of
the play:

l The end of the quarter
l The end of the half

These events stop the clock, so there is no
need to call a time out.

NOTE: If you call a time out, the game will
not charge it to you if your runner or receiver
steps out of bounds or your quarterback
throws an incomplete pass.

Play Calling-Two  Human Players
You can use either the keyboard or the play
calling buttons when playing against a friend
on the same computer. The keyboard is the
default. To use the mouse with the play but-
tons, use the Play Cal/choice from the
Options menu.

Using the Keyboard to Call  Plays
If you decide to use the keyboard to call your
plays, follow these guidelines. The plays are
printed on your enclosed play card.

l The home team coach uses the number
keypad to  enter his plays (be sure Num
Lock is on).

l The visiting team coach uses the number
row to enter his plays.

Piay Calling  Syntax
You must input FOUR characters when
calling plays.

1st digit--formation code (i-6, see play
card for formation codes)

2nd & 3rd digits-Play Number (01-99,
see play card for play numbers)

4th digit-Time out code (0 = No T.O.,
1 =  T.O.)

For example: 1101
1 = Pro Set

10=Play#
1 = T.O.

Player Substitution
If a player becomes injured, or is simply not
playing up to his abilities, you can make a
quick change using the Substitution menu.
Follow this procedure to substitute players:

1. Click the Substitute pull-down menu and
select a team, Visitor or Home. The list of
standard formations appears.
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2. Select the formation for which you want to
substitute players. The list of players for
that formation appears.

3. Select the player you wish to remove from
that formation. A list of eligible replace-
ment players appears.

4. Select a replacement player.

5. The game asks if you want to make this
substitution globally (across all forma-
tions). Select Yes to substitute globally,
No to substitute for only this formation.

6. Select Exit from the formation list to return
to the game, or repeat steps 2-5 to make
more substitutions.

Playing a Game Plan Game
Every week, coaches scout their opponents
and create detailed game plans to use in the
coming game. All-American College
Football's exclusive  Game Plan mode simu-
lates this experience, offering a unique and
fun way to get inside the coach’s mind!

Game Setup Selections
To play a game in Game Plan mode, you
must choose Game Plan in the Play Method
box on the Game Setup menu. In addition,
you have three different ways of playing a
Game Plan game, depending on what you
choose in the Game Type box.

Norma/-plays a single Game Plan game.
If you play a league game, the computer
updates season stats at its conclusion. If you
play an exhibition game, the game does not
update stats.

Repeat-plays a single game and gener-
ates the same outcome each time, given the
same computer clock date. Use Repeat if you
are in a league and want to watch the “offi-
cial” results.

Autoplay- plays  multiple games from a
league schedule. Use this choice if you are
running a seasonal simulation.

You also must set the Home Game Plan  and
Vis.  Game Plan selections to play a Game
Plan game. Choose whether you will create

the game plan before the game begins
(Manual), the computer will create the game
plan (Computer), or the game plans are
saved on your disk (Saved).

When you choose Let’s Do It!, the game dis-
plays your game plan form (unless the com-
puter is generating the plans). You can either
modify the form or choose to leave it as is.
When you press ESC, the form is written to
the hard drive in the default directory, and
the Game Plan module is loaded.

NOTE: Game plan forms are written with the
following file name convention:
[TEAMYR.GPD].  TEAM = the first four char-
acters of the team name, and YR = the year of
the team. A game-plan form for 93Auburn,
for example, would be named AUBU93.GPD.

Game  Options
When you play a game plan game, the com-
puter uses the same screens as it does when
playing a head up game, with the following
exceptions:

Two buttons labeled Continue  and No Pause
replace the play calling buttons on the main
screen. Select Continue to have the computer
animate the next play in the game. Select No
Pause if you want the computer to animate
each play of the game in succession without
a break in the action.

The following keys have special functions in
Game Plan mode:

Space Ear-Displays the pull-down menus
when you are paused between plays.

<F>-If playing in Autoplay  mode, this
toggles between fast and slow modes. Fast
mode tracks the ball position without animat-
ing the plays, while slow mode animates
each play.

<F1>-If playing in Autoplay  mode, this
tells the computer to finish simulating the
current game, save the spot in the schedule,
and return to the main menu.
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f-Toggles between animating a single play
at a time (and pausing) and animating all
plays without a pause. This key duplicates
the functionality  of the Continue and Next
Play buttons.

Modem Play
True football excitement is just a phone call
away with A//-American College Football’s
modem play module! Modem play allows
you to hook up with a friend and battle it out
on the gridiron. Sure, playing against a com-
puter can be entertaining, but one-on-one
competition is where the fun really  begins!

Equipment Needed
To play via modem, you and your opponent
must each have a registered copy of A//-
American College  Football and a modem
capable of communicating at the same baud
rate. The modem must be connected to the
computer and turned on. A//-American
College Football’s  modem play module can
accept baud rates from 1200-9600 bps.

Pregame Setup
Before establishing the connection, you
must make several selections on the Game
Setup menu. Follow the steps outlined below
and on the following page to prepare for a
modem-play connection. Be sure to follow
these steps in order. If you need an explana-
tion of any of these choices, they are sum-
marized in the Game Setup chapter.

Hint: You may find it easier to make a voice
call to your opponent while you are both
making choices on the Game Setup screen.
This way you can coordinate your selections
before hanging up and making the modem
connection.

Modem Play Setup: Step 1
Set the following options on the Game
Setup screen:

Play Method-Head Up
Game Type-Modem
Opponent-Human

Modem Play  Setup: Step 2
Set these choices, paying attention to the
note below:

NOTE: These settings can vary according to
your preferences, but with the exception of
the Calling Coach choice, both players must
make the same choice in a given category.

Tie Resolution-Tie, Overtime, or Sudden
Death

League to Use-League A-D (if league
game) or Exhibition (if exhibition game)

Teams-Choose a Home and Visiting
team, or a scheduled game if you are playing
a league game.

Weather-Use or Don’t Use

Set Weather-Manual or Computer

Month of Play-September through
February

Injuries-Use or Don’t Use

Coin Toss-Heads or Tails

Calling Coach-Me or My Opponent
(must be different on each computer)

Caller’s Team-Home or Visitor

Modem Ptay Setup: Step 3
Set optional parameters. These do not have
to be the same on both computers.

Comm. Port-COMI-COM4

Dial Prefix-ATDT or ATDP

Modem Initializer-Select only if you
need to change your modem’s initialization.

Dialing Directory
Once you have made all your Game Setup
choices and pressed Let's  Do It!, the Dialing
Directory screen appears. This is where you
add and maintain your list of opponent’s
phone numbers.

Before adding an entry, read through the next
two sections for tips on correctly  entering
your opponent3 phone number.
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Phone Number  Syntax
You can enter the telephone number in one
of two ways: without spaces between the
numbers OR with dash marks as separators.

Do not use parentheses. For example, the
long distance number (614) 555-1212 could
be entered two ways:

16145551212 or 1-614-555-1212

The first number 1 in the example is the long
distance prefix.

NOTE: If the number you are dialing is local,
you do not need to include the 1 or the area
code.

Vial inf l  Prefixes
If you have call waiting service, you can
temporarily disable it by entering the charac-
ters l 70, before the phone number in your
dialing directory. For example:

‘70.16145551212

The ‘70 disables the service, while the
comma inserts a pause before the phone
number to allow the phone system time to
reestablish the dial tone. If you are dialing
from a rotary-dial phone, you can sometimes
disable call waiting by replacing the * char-
acter with the number 11 (i.e., 1170,).

Should these suggestions not work, contact
your local phone company to determine what
set of characters turns off call waiting in your
area.

If you are dialing from a phone system that
requires a 9 (or another number) to reach an
outside line, enter that number before your
phone number in the dialing directory. You
may want to insert  a comma after the dialing
prefix to allow time for the system to reestab-
lish a dial tone.

Each phone number entry can include up to
20 characters. This should be enough room
for any number if you omit separators.

Follow these steps to add an entry to your
dialing directory.

Adding  a Dialing  Directory  Entry
1. Select Add Entry.  A blank entry appears.

2. Enter the player’s name, up to 20 charac-
ters.

3. Press <ENTER> to move to the Phone
Numberfield.

4. Enter the player’s phone number. Be sure
to follow the syntax rules and dialing pre-
fix commands (if applicable) described
above.

5. Press <ENTER> to move to the Baud
Rate field.

6. Type the baud rate to be used when com-
municating with this player. The choices
are 1200,2400, or 9600.

NOTE: Choose the highest common baud
rate between the two computers. If you
have problems with the connection, revert
to a lower rate.

7. Press <ENTER> to move to the Team
Namefield.

8. Team Name is an optional, 14-character
field where you can list the team your
opponent is coaching. It is useful if you
are running a large league and need to
keep track o f  which person coaches which
team.

9. Press <ENTER> when finished to add the
entry.

Modify  an Entry
To change any information in a particular
dialing directory entry, highlight the entry
and select Modify Entry. Press <ENTER>
repeatedly to access the field you want to
change. Type your changes. If your new text
is shorter than the old text, use the space bar
to blank out the unwanted text. Press
<ENTER> until you reach the end of the entry
to complete your change.

Delete  an Entry
Highlight a directory entry and select the
Delete Entry  button. The entry is removed.
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Save the Directory
Select Save Directory  to write all changes or
additions you made to disk. If you make a
connection without saving directory changes,
you will be prompted to save the changes
before the connection is established. If you
choose quit, you will not be prompted to
save the directory.

Quit
Select Exit from the File menu to exit the
game and return to the General Manager
menu.

Modem Init ial izer
The game’s programmers have designed the
Modem Play module to be as compatible as
possible with most modems on the market
today. In rare occasions, however, you may
need to change the modem initialization
string to use this module with your modem.

If you determine that you are having trouble
connecting because of an incompatible ini-
tialization, choose Modem Initializer. A pop-
up window appears. Type the new string.
Press <ENTER> when finished. Refer to your
modem manual for details on what the ini-
tialization should be for your particular
modem.

Make the Connection
To make a connection, highlight the dialing
directory entry you want to call and select
Call Opponent. The other player must select
Answer.

NOTE: Both players must choose these
options at roughly the same time.

The computer set to dial (determined by the
Catting Coach field selection on the Game
Setup screen) will send the dialing command
to the modem. The computer set to receive
will send the auto answer command to the
modem.

Terminal  Window
Once the game has established a connection,
a blank terminal window appears. You can
use this screen to type back and forth to your
opponent before the game begins, and send
files to each other, if needed.

Use this procedure to send and receive files:

When you are ready to send, communicate
with the other player via the chat box, press
the <ESC> key, and all necessary files will
be sent.

Beginning the Game
Once you have made the connection and are
ready to start the game, the Calling Coach
must press the <ESC>  key. This signals both
computers to close the terminal window and
transfer the required setup files between the
two computers.

When this is finished, the game loads and
you are ready to begin.

Chat Made
Any time during the game you can type mes-
sages in the chat window. Just begin typing.
The text will automatically appear in the win-
dow. Press <ENTER> to send the text.

HINT: Before calling your first  play, commu-
nicate via the chat box to verify that your
computers are in sync. Things you may want
to check: home and visiting team, rosters,
weather, ball placement and possession.

NOTE: The player with the slower machine
must call his plays first. Otherwise, the
modem connection can become out of sync.
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League Setup
As  the name suggests, All-American  College
Football was  designed with league play in
mind! Whether you are involved in a league
with a group of friends, or just playing
through a schedule against the computer,
you’re sure to enjoy the power and flexibility
of the League Setup program.

Setting Up Your League
When you select League Setup from the
General Manager menu, the program guides
you through the steps necessary to define
your league and set up your schedule. These
are all described on the following pages.

Create or  Modify
The program first asks if you want to create a
new league or modify an existing league.
Choose Create to start fresh, or Modify to
change the schedule for an existing league.
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Select  a League
Next, League Setup needs to know which
league file to create or modify. Select a
league from the menu. If you are creating a
new league, League Setup will continue ask-
ing you questions about how you want to
structure your league. If, however, you are
simply modifying a league, the league sched-
ule will appear, allowing you to make any
necessary changes,

Type of  League
League Setup allows you to model your new
league after the college set up, or design
your own. For seasonal simulations, choose
Default. If you are competing with a group of
friends, choose Design  to manually create a
league structure.

If you choose Design, the program prompts
you with the following questions:

l Select the league to model your confer-
ences (Pre 1992 or Current)

l Select conferences to use. (Select Cancel
when all conferences you wish to use have
been selected.)

l Choose the year of the teams (same or
different) and enter the two digit number
(e.g., 93.)

i Once you have answered all of these ques-
tions, you can begin creating your league
schedule. See Creating a League Schedule
later in this chapter for more information.

If you choose Default the program continues
with the questions in the following sections.

League  Definition
You have the option of choosing an actual
schedule for your league, or creating your
own from scratch. Choose Actual to  choose a
pre-defined schedule, or Create to make your
own match-ups. Using an actual schedule
saves you a lot of time.

If you decide to create your own schedule,
the program skips to the next question.

League Model
Choose Current or Pre 1992 for the league
model. Choose Schedule. Select the sched-
ule you want to use.

Choose  Year
You now have the option of creating a
league full of teams from the same year, or
from different years. If you choose Same, the
program prompts you to enter a two-digit
year representing the team files you want to
load (e.g., 93). If you choose Different, the
program prompts you to choose individual
team files.

Once you are finished making your team
selections, League Setup will look for an
existing league file on your hard drive. If it
finds one, the program will ask if you want to
overwrite it, or cancel the league creation.

Schedule  Editor
At the bottom of the League Setup screen is
the Schedule Editor. This is where you create
or modify a schedule for your league. _

Selection Buttons
The top section of the Schedule Editor con-
tains a row of five gray selection buttons.
Click on any of these buttons to set schedule
parameters. For example, click on the first
box to set or modify the game date.
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Action Buttons
Below the selection buttons are the action
buttons.

Top-Click on this button to move to the
beginning of the schedule.

Bottom-Select  this button to move to the
end of the schedule.

Add-Choose  this button to add a new
game to the schedule.

Delete-Select this button to remove the
currently selected game from the schedule.

Creating a league Schedule
When you choose to define your own league
or create your own schedule, you must use
the Schedule Editor to add games to your
schedule. Follow this procedure to create a
new schedule:

Creating a League Schedule
1. Click on the Add button at the bottom of

the screen. A blank entry appears.

2. Click on the first gray button in the
Schedule Editor. A box appears prompting
you to choose a month for your game.

3. Choose a month for the game to be
played. A list of calendar days appears.

4. Select the day the game will be played.

5. Click on the second gray button to choose
the visiting team. A list of teams in your
league appears.

6. Choose the visiting team.

7. Click on the third gray button to choose
the home team. A list of teams in your
league appears.

8. Choose the home team.

9. Click on the fourth gray button to choose
how the game will be played. A box
appears with the choices Head Up and
Computer.

IO. Select Head Up to schedule any type of
Head Up game (two people on one com-
puter, modem play, or vs. computer).
Select Computer to schedule any type of
Game Plan game.

i
11. Click on the final gray box to change the

game status.This  is optional. You will
only need this field if you are editing a
schedule and need to manually update a
game status.

12. Repeat steps 1-11 to add the remaining
games to your league schedule. When
finished, choose Save from the File menu
to save your schedule.

Printing a Schedule
To print your schedule, press <F3>  or choose
Print Schedule from the Options menu.

Modifying a league Schedule
If you need to change a game in your sched-
ule, simply select the game from the list and
use the selection buttons to modify the game
data. Don’t forget to save your schedule after
you have finished making all of your changes.

Managing Your league
Serving as a All-American  College  Football
league commissioner can be great fun. You
get to organize the participants, create the
league, set the schedule, and play the games
to determine official outcomes.

To get the most out of your league, follow
these league management guidelines.

Choosing Teams
You have a number of options,when  choos-
ing the teams that will comprise your league.
Here are just a few:

l You can use the Team Editor to modify
and/or handicap the teams that will be
included in your league.
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l You can mimic the college structure, let-
ting the computer coach the teams that
your friends don’t choose.

l You can choose an even number of teams
and design your own league structure.

Once you decide which teams to include
in your league, use League  Setup to create
your league.

Setting a Schedule
You also must set your schedule when exe-
cuting League Setup. Here are some sugges-
tions for schedule creation:

l If you are mimicking the college structure,
choose an actual schedule.

l When your season is over use the Bowls
module to set up the bowl games.

Choosing  a Play Method
Once you have created your league and
schedule, you must decide how you want to
play your games. That done, you must then
edit your schedule to set each game to the
correct game type (Head Up or Computer).
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As a rule of thumb, leagues run more effi-
ciently if only one game type is used. The
Head Up and Computer types are so radically
different, that trying to mix these styles of
play in your league can lead to confusion.

If you insist on mixing the Head Up and
Computer types in your league, try playing
the first half of the season one way, and the
second half another way.

NOTE: You can modify the game type selec-
tion for any game that has not been played.
For example, if a game cannot be played
because the team owners are both too busy
to get together, you can set that game to
Computer and have the computer generate
an outcome.

Running a Game Plan League
To run a league using Game Plan mode, you
will need to follow these steps each week to
determine game outcomes and inform the
participants of the week’s results:

1.  Obtain saved game plan files from each
participant. You create these files in the
Game Setup program by setting the Play
Method to Game Plan, filling out the game
plan form, and then saving it to disk by
selecting Let’s Do It!

NOTE: Game Plan files are saved in the
default directory under the file name
TEAMYR.GPO.

2. Replay each scheduled game. Be sure
to make these choices on the Game
Setup Screen:
Play Method-Game Plan
Game Type--Repeat
Vis. Game P/an-Saved
Home  Game Plan-Saved

NOTE: Be sure to select the correct league
and game. All other settings are optional,
but should be agreed upon by all partici-
pants before the league begins.

3. Repeat steps 1-2  until all games are
played for the week.

4. Send the game plan files to each partici-
pant so they can replay the weeks games.
Games must be replayed using the same
settings as in step two above. In addition,
the computer’s internal clock must be set
to the same date as on the schedule for
results to be accurate. Choose the visiting
team’s year.

5. Send the updated league file to league
participants so they can track how the
teams fared in that week’s action. This file
resides in the default directory, and is
named LEAGUE-?.LFR. The question mark
after the underscore character represents
the league you are running (league A, B,
C, or 0).

Participating In a Head Up League
While game plan leagues may capture what
coaches do to prepare for a game, the corn- 
missioner has a lot of responsibility. He must
replay all the games to determine official out-
comes. This takes a large time commitment.
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Head-up leagues, conversely, involve all
league participants, as each coach is respon-
sible for playing his scheduled game. All
league participants must follow the steps in
the procedure on the next page to report
game outcomes to the commissioner:

1. Following the league schedule, each par-
ticipant is responsible for playing the cur-
rent week’s game. You can play locally or
via modem. The Game Setup settings
should be as follows:

Play Method-Head Up
Game Type-Normal or Modem

NOTE: Be sure to select the correct league
and game. All other settings are optional,
but should be agreed upon by all partici-
pants before the league begins.

2. After the game, you and your opponent
must use the Remote League Data
program to extract your newly updated
team files.

NOTE: See the Remote League Data
section for instructions on extracting
your team files.

3. Both you and your opponent must send
your respective team files to the commis-
sioner. He will then use Remote League
Data to create an updated league file with
all the week’s results.

Updating the League File
As commissioner of a Head Up league, you
will be responsible for updating the league
file after each set of games. After you receive
updated team files from all participants, use
Remote League Data to overwrite the new
team data in the existing league file. Once
you’ve done this, send the new league file to
the participants so they can view the week’s
results and statistics.

NOTE: See the Remote League Data section
for more information about updating league
files.

league Tips
While serving as a commissioner can be lots
of fun, you must be well organized for your
league to run smoothly. Here are some tips
for efficient league management.

Ground Rules
Publish ground rules well ahead of your start
date. Your ground rules should address these
topics:

l Which game setup selections you will use
in your league.

l When team files are due to the commis-
sioner.

l How the commissioner will accept team
files (i.e., via E-mail, on disk, etc.).

l How many games will be played per
week. This should also be reflected in the
league schedule.

File Management
The commissioner is responsible for accu-
mulating and archiving all team files and all
league files for each week’s games on the
league schedule. We recommend that the
commissioner create a league directory.
Under that directory, he should create a sub-
directory for each week on the schedule.

For example, if the league directory is
C:\LEAGUE1,  these should be the additional
subdirectories:

l C:\LEAGUE1\WEEK01
l C:\LEAGUE1\WEEK02
: ;;;bEAGUEl\WEEK03

Once the commissioner has created the
directory structure, he should copy the initial
league file into the WEEK01 subdirectory.
After receiving all team files for the first week
on the schedule, he should copy these to that
same directory.
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When finished updating the league files,
he should copy the updated league file
to the next week’s subdirectory (i.e.,
C:\LEAGUE1\WEEK02).

Seasonal Simulations
If you want the computer to play an entire
season, choose Computer as  your game type
when filling out your league schedule. Then
follow the steps below to replay your season:

1.  Play each scheduled game. Be sure to
make these choices on the Game Setup
Screen:
Play  Method-Game Plan
Game Type-Autoplay
Opponent-Computer
Vis. Game Plan-Computer
Home Game Plan-Computer

NOTE: Be sure to select the correct
league.

2. Select the Teams button and choose the
1st game on the schedule.

3. Select an Autoplay  Speed (Fast or Real
Fast) from the Options menu.

4. Press Let’s Do It! to begin playing
the games.

If you want to interrupt the seasonal simula-
tion at any time, press the <F1> key. The
computer will finish playing the current
game, and then quit the simulation. To take
up where you left off, repeat the steps in the
Seasonal Simulations procedure.

Remote league Data
Running an online or play-by-mail league
has never been easier, thanks to A//-
American College Football’s  League Setup
and Remote League Data modules. As
described in the previous section, you use
League Setup to create your custom league
and set your schedule, then use Remote
League Data each week to update league
results from your online or play-by-mail
league.

Extracting  Team Files
As a participant in a Head Up league, you
must use Remote League Data to extract your
team file after you play a scheduled game.
When finished, send it to your commissioner
so he can merge it into the new league file.

1.  Choose Remote League Data from the
General Manager Utility menu. The pro-
gram asks you to choose a league file.

2. Select the league file that includes your
team (A-D). The program then asks if you
want to Extract or Overwrite.

3. Choose Extract. The game then displays
all teams in your chosen league file.

4. Select your team.

Updating League Files
If you are acting as commissioner of an
online or play-by-mail league, it will be your
responsibility to collect the updated team
files each week from your participants and
use Remote League Data to create the new
league file. Follow this procedure once you
have received all files for a given week on
your schedule:

1.  Choose Remote League Data from the
General Manager Utility menu. The pro-
gram asks you to choose a league file.

2. Select the league file you want to update
(A-D). The program then asks if you want
to Extract or Overwrite.

3. Choose Overwrite. The game then displays
all teams in your chosen league file.

4. Select a team.

5. Repeat the steps in this procedure to
update all teams in your league.
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Team Editor
Your copy of All-American College Football

 comes with a full-featured Team Editor mod-
ule that you can use to edit or create your
favorite teams.

The Team Editor supports full rosters and
allows you to assign different players to dif-
ferent offensive and defensive formations just
like college coaches do when preparing for
Saturday’s game! You can also print the team
file, roster assignments and player ratings
from the Team Editor’s Print menu.

How Stats Affect Performance
The team files that come with All-American
College Football represent the actual perfor-
mance of each player during the respective
season.

The season’s accumulated statistics for run-
ning backs, quarterbacks, receivers, kickers
and punt/kick returners are used to predict
player performance. For example, if a half-
back averaged 3.5 yards per carry and ran
the ball  15 times per game, he will perform
to those limits over the course of the game
(given a favorable defense).

If, however, your opponent frequently calls a
run defense keyed on the halfback, or you
decide to run the halfback more times than
his historical season average, his perfor-
mance will diminish considerably.

The linemen ratings are based on a combina-
tion of team and individual statistics. The rat-
ings for defensive linemen, for instance, are
based on the team’s yards per rush average,
the player’s number of sacks, and expert
evaluation of individual player performance.

Accessing the Team Editor
Choose Team Editor from the General
Manger menu to enter the Team Editor mod-
ule. The program initially asks if you want to
create a new team file or edit an existing one.
If you choose to edit an existing file, you
must then choose the team and year. If you
choose to create a new file, you must choose
a team and input a year. You are prohibited
from overwriting an existing team file when
using the Create option.

NOTE: You can switch between creating and
editing at any time by making the proper
selection from the Team Editor’s File menu.

Editing/Adding a Team
Use the procedure beginning on the follow-
ing page to edit an existing team. The steps
are the same for adding a team, except that
you must add, not change the data.

Editing an Existing Team
1.  Once a team file is loaded, choose the

type of players you want to edit from the
Category menu. The existing players for
that position appear, and the first player
on the list is highlighted.

2. Highlight the player you want to edit and
press <ENTER>. The cursor becomes
active in the Name field at the bottom
of the screen.

NOTE: If you want to add a new player to
this category, select an empty position and
press <ENTER>.

3. Type any new stats in the Data Editor
fields, pressing <ENTER> to move
among fields.

4. When finished editing a player, press
<ENTER> until the cursor moves through
all stats fields and displays the next player
on the list. This updates all changed
fields.
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5. To work with a different player type,
choose a new category of players from the
Category menu, or press <TAB> to cycle
through each type.

6. Repeat steps 1-5  until you are finished
updating your team fife.

7. Press <F4>  or choose Save from the File
menu to save your changes. If you try to
exit without saving, the Team Editor asks if
you want to save your changes before
quitting.

NOTE: All rushing categories contain one
assumed decimal place. For example, a
YPR of 34 is actually 3.4.

Editing Team Rosters
Use the following procedure to edit team
starters for each available formation.

1. Once a team file is loaded, choose Starters
from the Options menu. A menu appears,
listing the formations you can edit.

2. Select the formation you want to edit. A
list of current starters appears, with their
position, rush rating and pass rating listed
to the right of their names.

NOTE: The rush and pass ratings are rela-
tive to the players position. For example, a
defensive back is rated as to how well he
plays against the run and pass, while a
running back is rated on how well he runs
and receives.

3. Select the player you want to remove from
the lormation. A list o f  players for that
position appears, along with their rush
and pass ratings.

NOTE: If you made the wrong formation
choice, select Don’/ Substitute to return to
the Formation menu.

4. Select the new player. He is inserted into
the lineup and the Formation menu reap-
pears.

5. Repeat steps 2-4 to edit more formations.
When finished, choose Save from the File
menu or press <F4>  to save your changes.
Choose Exit to return to the Team Editor.

Printing From Team Editor
You can print three different reports from the
Team Editor Print menu:

Print Team-A listing of all players, their
historical statistics, and their rush/pass rat-
ings (if applicable).

Print Formation-A report of the players
that make up each offensive and defensive
formation, including their rush/pass ratings
and position.

Print Ratings-A listing of each player on
the team, sorted by position, that includes
his rush and pass ratings.

League Leaders
Besides accumulating statistics for the Stats
Keeper module, All-American College
Football also tracks league leaders through-
out the season. You can use these reports
as a valuable scouting tool, or to follow your
favorite players as they fight their way to
the top!

Entering leaders
Select League Leaders from the General
Manager menu. Before  you can display any
statistics, the module asks you what league
file to open. Select a league, or choose
Cancel to exit back to the General Manager
menu.

Viewing and Printing leaders
You can either view or print the league lead-
ers. To view leaders, simply select the cate-  
Qory you want to display from the View pull-
down menu. To print leaders, make a selec-
tion from Print pull-down menu. You can
change leagues from the File menu.
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You have the choice of printing either to disk
or to the printer.

If you print to disk, a dialog box appears,
showing the file name created. Select OK to
write the file to disk. The file is written to the
main All-American  College Football directory
(i.e., C:\ACF95).

Some printed reports combine more than
one View category.  Refer to the chart on the
following page to learn what information is
printed on what reports.

View/Print Cross  Reference
Report  Name-view  Categories Reported

Passing-Passing leaders only

Run/Receiving-Rushing leaders,
Receiving leaders

Special Teams-Kick Returners, Punt
Returners, Kicking, Punting

4 0

Individual  Defense-Individual Oef. only

Teams  Stats-Team Offense, Team
Defense, Team Misc.

League Leaders-The top ten leaders for
each category

T h e  Help  Menu
Player stats won’t appear in the League
Leaders reports unless they meet the pro-
grams qualifications. You can view these
thresholds from the Help menu.

Stats Keeper
At the heart of All-American College  Football
is a sophisticated statistics tracking and
reporting program that keeps tabs on all
league and exhibition game activity. Since
the key to winning football games is knowing
your opponent’s strengths and weaknesses,
the Stats Keeper is an invaluable tool to use
in preparing for war on the gridiron!

Entering Stats Keeper
Choose Stats Keeperfrom the General
Manager menu. The program appears, with
the stats from the last complete game on
the screen.

NOTE: The Stats Keeper also appears after
each completed game if you turned Game
Summary to On when  on the Game Setup
screen.

Viewing and Printing Statistics
You can either view or print the statistics
tracked by Stats Keeper. To view statistics,
simply select a pull-down menu and choose
the stats you want to display. To print statis-
tics, select the Print choice  in each pull-
down menu.

You have the choice of printing either to disk
or to the printer. If you print to disk, a dialog
box appears showing the file name created.
Select OK to write the file to disk. The file is
written to the main All-American  College
football directory (i.e., C:\ACF95).

Stats Keeper Menus
The following sections describe each Stats
Keeper menu:

File
This is where you change league files within.
Stats Keeoer. Select League to load a differ-
ent league file. Choose Exit to quit Stats
Keeper and return to the General Manager
menu.



G a m e
This menu has selections that summarize the
numbers from the most recently played
game. The Offense selection  displays offen-
sive statistics, including:

l Team totals
l Scores by quarter
l Passing, rushing, and receiving statistics

The Defense section shows the following
defensive statistics:

l Kick and punt returns
l Tackles, sacks, and interceptions
l Kicking and punting statistics

Drive Summary
Select View from  the Drive menu to list the
number of plays, yards gained, time of pos-
session, result, and score for each of the
game’s possessions. The report is grouped
by quarter, This screen also displays team
summaries in categories such as number of
first downs, number o f  fumbles,  passing
plays/yards, rushing plays/yards, etc.
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Records
The Records menu includes stats reports for
individual, team, offensive, and defensive
league records. There are 67 categories in
all. Each listing shows the record, the game
in which it was set, and the team that set the
record. Individual records also show the
player who set the mark. Select the respec-
tive menu choice to display these records.

If you want to view the criteria used for
including a player or team in the record
book, choose Qualifications. Select Clear
only if you want to wipe out all the league
records.

HINT: Choose Clear at the end of the
regular season to track separate records for
bowl games.

Season

To view season stats, you must first select
a team and year. To choose a team, select
Load Team.

Once you have selected a team and year,
select the function you want under the
Season menu. Offense displays  team offen-
sive statistics, while Defense shows  team
defensive stats and game scores. Select
Clear only if you want to wipe out the season
stats for the selected team.

HINT:  Choose Clear at the end of the
regular season to track separate statistics 
or bowl games.

M V P
As the name suggests, All-American
College Football has  an MVP program
that selects the Nation3 Most Outstanding
College Football Player. Votes are calculated
based on player performance, and the totals
xea;;,rted out to see who wins this coveted

Top 20
As the name suggests, All-American College
Football has a Coaches’ Poll to determine the
National Champion. Votes are compiled and
calculated based on win/loss record and
schedule strength. If a team is undefeated
playing an easy schedule, there is a chance
they will not win the crown. The “Pollsters”
look at more than the win/loss columns to
decide this National Championship.
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Glossary of Terms
This glossary is desighed  to both define the
terms used in All-American College Football,
and offer some tips on how to best utilize the
tactics they describe. To help you find the
definitions you need, the terms are grouped
by function. Any codes next to the definitions
represent the corresponding code in the
Call Preset Play screens and enclosed
Play Cards.

Defensive Formations
The formation of your players is the starting
point of any play. There are six defensive for-
mations supported in All-American College
Football, each designed to stop a particular
offensive set.

3-4
The 3-4 is a traditional formation with three
down linemen and four linebackers (a down
lineman is a defensive player who positions
himself on the line of scrimmage and starts
the play in a three or four-point stance). It is
a good read formation because the line-
backers have time to react to the play. It also
allows decent short pass coverage because
of the extra linebacker.

4-3
A 4-3 formation is a flip-flop of the 3-4. You
have four down linemen and three lineback-
ers. It’s also a basic set, but better
the run.

5-2
Add another lineman to the mix, subtract a
linebacker, and you have the 5-2. This for-
mation is stacked against the run, and can be
a gamble in passing situations.

7-4
The 7-4, also known as goal line defense, is
best for stuffing the run. Don’t use it in the
open field, however, or you’re liable to be
burned by a deep pass. This formation has
two linebackers, seven down linemen and
two defensive backs. Reserve the 7-4 for use
within your own five yard line.

Nicke l
Traditionally used in 3rd down-and-long sit-
uations, the nickel package removes a line-
backer from the 3-4 and adds a defensive
back.

Dime
The dime formation has six defensive backs,
and is used when you know the other team
is going deep. Use the dime package to pre-
vent deep passes if you’re leading late in
the game.

Defensive  Strategies
Once you set your alignment, you have
to tell your team how to play their positions.
The following terms describe the defensive
strategies you can use in All-American
College Football

Linemen and Linebackers
The following terms apply to your linemen
and linebackers:

Alignment
Choosing an alignment determines how your
defensive linemen will space themselves on
the line before the snap. Choose the align-
ment style best suited to stopping the type of
play you think your opponent will call. The
alignment choices are listed below:

Tight-Best for stopping inside running
plays like dives and draw plays.

Spread-Best for stopping outside running
plays like slants and sweeps.

Head Up-A conservative, helmet-on-hel-
met alignment.



Kay Runner Pursuit
Predicting what player will carry the ball is IS your opponent going to run a quick-hitter
another key to a successful run defense. You or a slow-developing counter play? You pre-
can have your defense key on: dict  how fast the play will develop by setting

The halfback (code A)
the pursuit code:

The fullback (code B)
Quick  (code 1)-You’re  expecting a
quick-hitter.

If you choose to key on the quarterback, you
are essentially calling a no-key defense.

Medium (code Z/-You’re playing it safe.

Line Strength
Slow (code 3)-You’re  anticipating a

The strength code allows you to anticipate in
slow-developing play.

what direction the ball carrier will run. The Stunts
choices are: Stunts are fancy footwork executed by defen-

Strong (code 4)-The  ball carrier will run
sive ends and tackles to confuse the offense.

 
to the side of  the offensive line where the

The twisting stunts are often used by teams

tight end is located.
with under-powered defensive lines as a way
to equalize the competition. There are four

Middle  (code 5)--The  ball carrier will run types of stunts:
up the middle. Blast-The tackle and defensive end try to
Weak (code 6)-The  ball carrier will run plow through the line as quickly as possible.
to the side of the offensive line opposite the
tight end.
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Twist  Weak-The tackle and defensive end
furthest from the offensive tight end quickly

Under Zone-The secondary covers the
area 5-10 yards behind the line of scrim-

switch positions when the ball is snapped. mage. This is also called a Short Zone.

Twist Strong-The tackle and defensive
end opposite the tight end switch positions
when the ball is snapped.

Twist Both-Both tackles and defensive
ends switch when the ball is snapped.

Defensive Secondary
These terms apply to techniques employed
by the defensive secondary:

Coverage/Zone  Type
The coverage selection tells your defensive
backs how to play the receivers. There are
four different ways to align your defensive
secondary.

Man-to-Man- Each  defensive player is
matched with a corresponding eligible
receiver.

Over Zone-The secondary covers the area
IO-15 yards behind the line of scrimmage.
This is also  called  a Medium Zone.

Deep Zone-The secondary covers the
area 15+ yards behind the line of scrimmage.

Man to Man
Man-to-man coverage is good if your sec-
ondary is highly skilled, but is more risky
because the receiver only has to beat one
man to make the play. Zone coverage is more
conservative, and is more effective when the
pass is deep because the secondary has
more time to adjust to the quarterbacks
throw.

Coverage  Technique
You also must tell your secondary how close
to cover their receivers. The options are:
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Tight  (code 1)-Best  for defending simple
routes. Tight coverage increases your chance
of getting an interception, but also increases
the chances that the receiver will turn a short
pass into a long gain.

Medium (code 2)-This  is a conservative
coverage which gives no real advantages or
disadvantages.

Loose (code 3)-Best  for defending com-
plex pass routes where the receiver is mak-
ing two or three direction changes.

. Split End (code X)

. Tight End (code Y)

. Flanker (code Z)

Blitz
The  hIit  is a risky  play  where you send
one or more linebackers  or a defensive back
toward the quarterback. This weakens the
pass coverage, but can lead to a sack or
hurried throw. There are three types Of
blitz plays:

5-man blitz-sends 1 linebacker

6-man  blitz--Sends 2 linebackers

7-man blitz-sends 2 linebackers and a
defensive back

The more backs you send toward the QB, the
riskier the play becomes, on both sides Of
the ball!

Offensive Formations
These offensive formations tell your players
where to line up before the play is called. As
with defensive formations, each is designed
to be effective with different play types. The
six offensive formations are as follows:

Pro Set
The Pro Set is the stock formation for most
NFL teams. It has two running backs split
behind the QB, two receivers, and one tight
end. The Pro Set is effective for both running
and passing plays, but is not optimized for
either one.

1 Formation
This is another traditional scheme, with two
running backs, two receivers, and one tight
end. Unlike the Pro Set, the backs line up
directly behind the quarterback (which forms
an ‘I’ pattern).

Run & Shoot
Made famous recently by the Detroit Lions
and the Houston Oilers of the NFL, this for-
mation uses four wide receivers and only one
running back. There is no tight end.

White the Pro Set and 1 formations operate
under the notion that it is best to set up the
pass with a strong running game, the Run &
Shoot is designed to set up the run by open-
ing up the game with frequent passes. It is
primarily a pass formation, but can be effec-
tive for running plays once the defense is
lulled into keying on the pass.

3-Wide
This lormation replaces the tight end with
another wide receiver. There are two running
backs. Since the tight end is frequently used
as a lead blocker on running plays, this for- 
mation  sacrifices the run for more passing
firepower.
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This is a good play to run if you have a quick
receiver. A quick defense  can be easily
tricked by a well-executed reverse.

QB Bootleg
As the name suggests, this play is run to the
outside by the quarterback. The play starts by
both running backs moving one direction.
The QB may fake a handoff before running
around the opposite end of the offensive line.

Since the quarterback is not a primary ball
carrier, this play is best used sparingly
throughout the game. It can succeed, howev-
er, against quick tight defenses. Your QB is
sure to be stuffed against a medium or slow
spread defense.

counter Plays
Any running play save the QB Bootleg and
Reverse can be run as a counter play. During
a counter, the offensive line and primary
blockers move one way while the ball carrier
runs in the opposite direction. This serves
to confuse the defense, and catch quick-
reacting players off guard.

52

Counters work best against quick defenses.
Slow defenses, however, are designed to stop
counter plays, so don’t be alarmed if the
other team is ready to thwart your counter.

Offense Strategies: Pass Offense
Todav’s high-powered  offenses rely on the
pass’as much as the run, so you’d better be
prepared to throw the ball down field. If you
aren’t ready, you’ll run the risk of being
blown out before the first half is over!

The first few definitions in this section
explain the components of a pass play, the
type o f  drop-back, the receiver, the pattern,
and the distance while the remainder dis-
cusses each play in detail.

Dmp Back Type
There are tour different ways the quarterback
can start a pass play.

Each is designed to exploit different defens-
es. The drop-back types are as follows:

Straight  Drop (code 6)-The  quarterback
takes the ball from center and drops 5-7
steps straight back before setting up for the
pass. This is the traditional setup for most
passing plays. If the line holds, the straight
drop gives the QB time to survey the defense
and his receivers before throwing the ball.

Play  Action (code 7)--The  quarterback
takes the ball from center, but fakes a hand-
off to a running back as he drops back into
pass position. Effective play-action quarter-
backs hide the ball behind their thigh after
faking the hand-off, further confusing the
defense.

NOTE: A well-executed play-action pass
should cause the linebacker to run forward
to stop the run. This opens up the middle
of the field for a high-percentage short or
medium pass.

Roll Out (code 8)-This  type of pass
gives a mobile quarterback running room to
either meet his receiver on one side of the
field, or improvise a passing play. It’s good if
your offensive line is weak, because it allows
the QB to free-lance in the backfield and
make his own play.

NOTE: Throwing on the run is more difficult
than passing from a set position, so what
you gain in creativity you lose in pass per-
centages. Still, if the QB is has both an accu-
rate arm and good mobility, he can use the
roll-out drop to his advantage.

Shotgun (code 9)-This style, made
famous by Roger Staubach and the Dallas
Cowboys, allows the quarterback to get into
passing position much more quickly than
any other drop-back style. The quarterback 
lines up 5-7 steps behind the center, who
snaps the ball to him to start the play.
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NOTE: Shotgun  formation is used to thwart Fullback (code B, 5)-Same  as halfback.
a good pass rush or blitz In these situations,
the quicker the quarterback can get the ball, Tight End (code Y, 7)-The  tight end on

the sooner he can get rid of it and avoid a most football teams is built like a small line-

sack. Passes out of the shotgun formation man or big receiver, primarily because he

are generally  less accurate than those from a does a lot of blocking. Due to their size, they
 

traditional 7-step  drop due to the hurried are often slower than the other receivers, but

nature of the play
harder to tackle.

Receivers
Split End (code X,  8)-The  split end is a

Once you’ve decided on a drop-back style, wide receiver who lines up on the left side of

you must choose your receiver. Receivers are the line. He and the flanker are the key

represented by two different codes in All- receivers in any pass offense. They combine

American College Football, a letter and a speed with excellent pass-catching ability to

number, The following  summarizes the eligi- pose a threat anywhere on the field.

ble receivers and their respective codes: Flanker (code Y, 9)-The  flanker is a wide

Halfback (code A, 4)-A halfback who receiver who lines up on the right side of the

can catch the ball is a real  asset to any foot- offensive line.

ball team. It is rare, however, that any run- W-Back  (code W, 6)-A  fullback in the
ning back can catch as well as a full-time run-and-shoot formation who lines up in the
receiver, Keep this in mind when scouting slot. He is essentially an additional flanker.
your team and. ultimately,  when deciding  on
a receiver.

Pass routes are designed to shake the receiv-
er free of his defender so he can make the
catch. The more moves a receiver makes, the
higher probability he will be open to catch
the ball. However, more moves take more
time. The more time the QB is waiting for his
receiver to get open, the more likely he will
be sacked. Weigh these factors carefully
before,making a decision.

The pass routes available in A//-American
College  Football are summarized below:

F/are-Similar to the swing pass, but the
halfback or fullback is running more toward
the sideline when the pass is thrown.

Hitch-When a hitch pattern is run, the
receiver runs past the line of scrimmage but
underneath the linebackers. He then cuts left
or right toward midfield to receive the pass.

Drag-This is when the receiver (usually
a running back) runs under the linebackers
and then cuts across the held. It is always a
short  pass.

Screen-The screen pass is designed to
fake the defense into running past the receiv-
er toward the quarterback. When he’s about
to be sacked, the QB flips the ball across
the field to an open receiver (usually a half-
back or fullback) who has a wall of blockers
in position to knock down any would-be
tacklers.

Seam-The seam is a straight pass pattern
where the receiver tries to find a gap (or
seam) between the defensive  backs. It is a
short one move pass.

Slant-A slant is thrown to a receiver cut-
ting across the field diagonally toward the
opposite sideline.

Out-This type of pass is thrown toward
the sideline, usually so the receiver can get
out of bounds quickly to stop the clock late
in the game. The receiver runs upfield,
changes direction, and then sprints toward
the near sideline to meet the ball. Exact tim-
ing is crucial to this play’s success.
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Curl-A  curl pass is thrown right at the
receiver’s back. At the last minute the receiv-
er turns around to meet the ball. He should
not have to run back toward the QB to catch
the ball.

Comeback-The comeback pass is thrown
beneath the receiver. He sprints upfield then
quickly stops and runs back to meet the ball.
If executed well, the receiver will be able to
shield the ball from the defender and make
an easy catch.

Cross-The receiver runs upfield and then
abruptly cuts 90 degrees toward midfield to
meet the pass. Crossing patterns leave the
receiver open to vicious hits by the defense,
so they are often run by the tight end.

Flag-When a receiver runs a flag pattern
he starts toward the center of the field and
then cuts toward the left or right corner of the
end zone. It is the opposite of a Post pattern.
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Post- A  post pattern starts on the sideline
and breaks toward the goal post. The QB
throws the ball toward the center of the field,
and the receiver must time his stride to meet
the ball where it has been thrown.

Streak-A streak is thrown over the shoul-
der of the receiver as he sprints forward
toward the end zone. It is very difficult to
execute, but when complete, can result in a
big gain.

Out and Up-This pattern is designed to
fool the defender into stopping short to
defend an out pattern. After laking to the out-
side, the receiver streaks downfield. This is
another complex pass that is hard to com-
plete, but has a major pay-off if successful.

Play Calling Codes
Nate: You can print play diagrams
/or all plays listed from the Genera/
Manager’s menu.

O f f -
/low to call plays
You must input four characters when
calling plays:

1st digit-Formation Code (l-6, see
formations below)

2nd and 3rd digits- Play Number
(01-99),  see plays below

4th digit-Time Out Code (0=No  T.O.,
1 =T.O.)

Example: 1011

1 =Pro Set, 01 =Play  #  1  =T.O

Formation Codes
These are the formation codes and
corresponding formations available for
offensive plays:

1 1=Pro Set

2=1  Formation

3=Run  & Shoot

4=Wishbone

5=Short  yardage

6=3 Wide

How to Read Running  Plays
The running plays listed below can be read
in the following manner:

I
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Running Plays:  Offense
01) 21 HB C

02)
W
04)
05)
06)
67)
08)
09)
10)
11)
12)
13)
14)
15)
16)
17)
18)
19)
20)
21)
22)
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22 H B
23 HB
24 H B
25 HE
26 H B
27 H B
28 H B
29 H B
21 H B
22 H B
23 H B
24 HE
25 HE
26 H B
27 HE
28 H B
29 H E
31 FB
32 FE
33 FB
34 FB

Draw
C D i v e
C Dive
C Trap
C Trap
C Slant
C Slant
C SWP
C S!Wp

Drew
Dive
D i v e
Trap
Trap
Slant
Slant
s w e e p
Sweep

C Draw
C D i v e
C Dive
C Trek

23) 35 FB

24) 36 FB

25) 37 FB

26) 38 FB

27) 39 FB

28) 31 FB

29) 32 FB

30) 33 FB

31) 34 FB

32) 35 FB

33) 36 FB

34) 37 FB

35) 38 FB

36) 39 FB

37) 76 Y

38) 89 X

39) 96 2

4) 11 c!B

41) 12 Q B

42) 18 IIB

4) 19 Q B

44) 10 QB

C Trap
How to Read Passing Ptays

C Slant
The passing plays listed below can be read in the following manner:

C Slant
C Sweep
C s w e e p

Draw
Dive
Dive
Trap
Trap

64 A
II I

Swing
I

5
23Distance

Slant
Sweep

Reverse
Reverse
Reverse
Draw
Scramb le
Bootleg
Bootleg
Drop

6 =  Straight Drop
7 =  Play Action
B=  Roll Out
9 i Shotgun

4orA=HB Swing Screen
5orB=FB Drag Hitch
7orY=TE Straight Curl
8orX=SE Comeback  Up  &Out
SNZ=FL Seam Out

Slant CKXS
Post out&up
FlY Streak

P”“““”  PJays:  OfvIse
45) Flare 5 55) 65 B Drag 4
46) 64 A Screen -5 56) 95 B H i t c h 6
47) 84 A Drag 5 57) 65 B Seam 11
48) 94 A Hitch 7 58) 75 B Curl 12
49) 64 A Seam 12 59) 85 B Comeback 15
50) 64 A Curl 12 6’3) 65 B Streak 2 6
51) 64 A Comeback 15 61) 75 x Screen -1
52) 64 A Streak 24 62) 68 X Seam 7
53) 65 B Flare 4 63) 68 X Dot 9
54)  65 B screen -4 64) 68 X Slant 11

Pass distance
in yards
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65)
66)
67)
68)
69)
70)
71)
72)
73)
74)
75)
76)
77)
76)
79)
80)
81)
82)
63)
64)
65)
W
67)

88
68
76
98
6.8
68
70
66
77
67
67
97
67
97
a7
67
77
67
79
69
99
a9
69

X CkXS 13

X Comeback 15

X Comeback 17

X Streak 20
X CUrI 23
X Post 30
X Out &  up 33
X Streak 45
Y SCMl -1
Y Seam 7
Y Hitch 7
Y Out 7
Y Out 9

Y CVXS 11

Y Comeback 13
Y Streak 15

Y Post 17
Y Streak 25
Z SCNl -1

Z Seam 7
Z Seam 9
Z Out 9
Z Cud 12

88) 79 z Cross 13
89) 99 z Comeback 15

90) a9 z Comeback 17
91) 69 Z Streak 20

92) 69 Z P o s t 29

93) 79 z Out&Up 31

94) 69 Z Streak 45

Special  Teams:  Offense
A//  kickof/  plays (95-99)  are handled  by
play calling buttons.

95) Normal

96) Squib

97) Onside

98) Punt

99) Field Goal

HOW  to call  plays
You must input four characters when
calling plays:

fst  d i g i t - F o r m a t i o n  C o d e  ( I - 6 ,  s e e
formations below)

2nd and 3rd digits-Play Number
(ol-99),  see plays below

4th  d ig i t -T ime  Out  Code  (O=No T . O . ,
1 =T.O.)

Example: 1011

1=3  -4,01 =Play  t, 1 =TO.

A
Tight

I

5 =  Middle 2 =  Medium
6 =  Right 3= Slow

Tight
Spread

Format ion  Cadas
These are the lormation  codes and
corresponding formations available for
deffensive plays:

~ 1=3-4

2=4-3

3=5-Z

4=7-4

~ 5=Nickel

6=Dime

How to Read /tanning  Hays
The running plays listed below can be read
in the following manner:

t
Man

;
piJp&piii&

A-HE Man = Man-to-Man Tight
B-FE Short =  Short 2ane Medium
Blank = No Key Medium =  Medium Zone Loose

Deep = Deep Lone
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Running Plays:  Defense
01) 52 Tight A Man 1

I :

02)
03
04)
05)

06)
07)
08)
0%
10)
11)
12)
13)
14)
15)

16)
17)
18)

19)
20)
21)

22)
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53 Tight A Man 1

63 Tight A Short 1

42 Tight A M e d i u m  2

43 Tight A Deep 3

63 Tight A Man 2

42 Spread A Man 1

43 Spread A Man 1

42 Spread A Shari  1

42 Spread A M e d i u m  2

42 Spread A Deep 3

51 Tight A Man 1

51 Tight A Short  1

51 Tight A M e d i u m  2

61 Tight A Deep  3

51 Tight A Man 2

41 Spread A Man 1

41 Spread A Short 1

41 Spread A M e d i u m  2

61 Spread A Deep 3

52 Tight B Man 1

52 Tight 6 Short 1

!3)
!4)
!5)
26)

2 7 )
28)
29)
30)
3 1 )
32)

33)
3 4 )

35)
3 6 )
37)
3 6 )
39)
40)
41)
4 2 )
43)
4 4 )
45)
46)

6 3 Tight B M e d i u m  2

5 2 Tight 6 Deep 3

52 Tight 6 Man 2

42 Spread 6 Man 1

42 Spread B Short 1

42 Spread 6 M e d i u m  2

42 Spread B Deep 3

51 Tight 6 Man 1

51 Tight B Short 1

6 1 Tight El M e d i u m  2

51 Tight B Deep 3

51 Tight 6 Man 2

61 Spread B Man 1

41 Spread 6 Shod 1

41 Spread B M e d i u m  2

41 Spread 6 Deep 3

51 Tight Man 1

51 Tioht Short 1
61 Tiiht
51 Tight

41 Spread
61 Spread
41 Spread

62 Spread

Medium

Deep
Man
Short
Medium
Deep

How to  Read  Pas&#  P/ays
The passing plays l isted below can be read in the fol lowing manner:

,+j&& & ,$yygij  &, &,

5  = Middle 2 = Medium Man = Man-b-Man X=  Double  SE 1  =Tight Tight A=HB
6 = Right 3 = slow Short = Shod Zone Y=  OoubleTE 2 = Medium Spread B = FB

Medium = Med. Zone Z=OoubleFL  3=toose
oeep  = oeep zone

Blank = No Key

Pasinfl P lays :  Defense I
47) 41 Man 1 Tioht A 59)
48j

49)
50)
511
5 2 )
5 3 )
5 4 )
55)
5 6 )
5 7 )
56)

41 Man 2
41 Mall 1
41 Man 2
63 Man 2
5 1 Man X l
41 Shod x2
41 Man Y l
51 Short Y2
42 Short Y2
41 Short Y2
61 Man Zl

Spread

Spread
Tight
Spread
Spread
Spread
Tight
Spread
Spread

A
B
B

&read B

W
61)
62)
6 3 )
W
65)
66)
67)
68)
69
70)
71)

41
61

52
43
5 1

61
63
41
41
53
63
41
5 1

Short 22 Tight
M e d i u m  1 Spread A
M e d i u m  1 Spread A
Man Xl Spread A
Medium X2 Spread
Medium X2 Spread A
Medium X2 Spread A
M e d i u m  X 2 Spread B *-
Man Yl Spread B
Medium Y2 Spread B
Medium Y2 Spread A
Man Zl Spread A
M e d i u m  22 Spread A
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72)
73)
74)
75)
76)
77)
78)
79)
80)
81)
82)
83)
84)

41 Medium 22 Spread E
63 Medium 22 Spread 8

41 D@P
41 DEP
41 DIP
41 Deep
51 Deep
61 Deep
41 Deep
61 Deep
51 C&p
41 Deep
61 DW

Printed in U.S.A.
52H7746
64

X2 Spread A
Xl Spread A
x 3 Spread 6
Yl Spread 6
Yl Spread B
Yl Spread B
Zl Spread A
Zl Spread
22 Spread
23 Spread
23 Spread

Blitzes: Defense
85) 41 Blitz (5) 1 Spread
86) 51 Blitz (5) 2 Tight
87) 51 Slitz(5)  2 Head Up
88) 61 Blih(5)  2 Spread
89) 41 Blitz(6)  2 Spread
90) 51 Blih(6)  3 Tight
91) 61 Blitz (6) 2 Spread
92) 41 Blitz (7) 2 Spread
93) 51 Blitz (7) 1 Tight
94) 61 Blitz (7) 2 Spread
Note: The number in parentheses indicates the number
ot players  blitzing.

Specia l  Teams:  Defense
All kickoff plays (95-99) are handled by
play calling buttons.

95) Normal

96) Squib
97) Dnside
98) Punt Return

99) Kick Block




